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Welcome to CIM Explorer

1 Welcome to CIM Explorer

Accessing data about a computer has never been easier!

CIM Explorer is the premier tool for accessing managed data about any local or re-

motely connected computer. Whether you are using Windows Management Instru-

mentation (WMI) or Common Information Model (CIM), CIM Explorer is the tool of

choice. Let CIM Explorer help you get a handle on classes along with their properties

and methods. 

For a complete list of current features, visit the CIM Explorer product page.

About this documentation

This help is designed to show you how to use CIM Explorer and also as an ongoing reference while

you are working with the tool. You can do a quick overview to get started, work through the topics

in detail, and refer back to this guide for additional information when needed.

Getting started - new users

· Download and install CIM Explorer.

· Quickly learn the basics of the program in Getting Started .

· Visit the support forum to get help from SAPIEN staff and other experienced CIM Explorer users.

10

https://www.sapien.com/software/cimexplorer
https://www.sapien.com/software/cimexplorer
https://www.sapien.com/forums/viewforum.php?f=24
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2 Introduction

This section provides an overview of the CIM Explorer features, lets you know how to get answers to

your questions, and shows you how to purchase directly online or through a reseller.

2.1 About CIM Explorer

CIM Explorer allows you to use Common Information Model (CIM) and Windows Management Instru-

mentation (WMI) to view the vast landscape of managed data on any computer. Utilizing a simple, intu-

itive design, CIM Explorer enables newcomers and experts alike to be more productive.

Key Features

· View all CIM and WMI managed data in a hierarchical tree structure, including namespaces and

classes.

· View all properties and methods of a class, with help descriptions.

· Search for text in the name or description of a class, property, method, or all of the above, and

then filter the results.

· Explore and query any class on a local or remote computer. Use CIM Explorer preset queries or

write your own.

· Run in PowerShell or PowerShell Core. Click to run a Get-CimInstance command for any class or

property in the built-in Windows PowerShell console.

· Export query results in HTML, XML, CSV, or text format.

· View and run built-in help examples customized for your computer. Or, click to search for the

class description in Google or MSDN.

WMI and CIM

Windows Management Instrumentation (WMI) envisions all of Windows hardware and software as a

set of management classes that you can use to view and script any Windows system. It's the Mi-

crosoft version of WBEM, an industry-wide environment-independent system that abstracts generic

computer system features—like physical and logical disks—so you can view, automate, and manage

them on any system.

WMI is Microsoft's implementation of the Common Information Model (CIM), an industry standard

that represents systems, applications, networks, devices, and other managed components. CIM ad-

heres to the DMTF standard, which makes it ideal for cross-platform environments. The CIM classes

are the parent classes upon which the WMI classes are built. 

https://docs.microsoft.com/en-us/powershell/module/CimCmdlets/Get-CimInstance?view=powershell-6
https://en.wikipedia.org/wiki/Web-Based_Enterprise_Management
https://en.wikipedia.org/wiki/Distributed_Management_Task_Force
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Beginning in Windows PowerShell 3.0, Microsoft recommends using CIM cmdlets, such as Get-

CimInstance, instead of the traditional Get-WMIObject cmdlet. Beginning with PowerShell 7, Get-

WMIObject is no longer available.

Why use CIM Explorer?

CIM Explorer is like having an assistant who is a CIM and WMI expert. It knows the classes,

namespaces, and properties. It caches in advance to speed up searches. It writes queries for you and

runs them with a click, either in its handy display or in its Windows PowerShell browser. It knows

VBScript and PowerShell, and it teaches you its query language by generating commands that you

can view, copy, and reuse.

  See a real-life example of how to use CIM Explorer .

  CIM Explorer does not run elevated by default. Some CIM classes and their properties, or meth-

ods, require elevation. You will need to run CIM Explorer elevated to access protected elements. 

Product Updates

You can learn about product updates on our blog and in the release build log, and you can also

submit product feedback and suggestions.

· Check out the CIM Explorer articles on the SAPIEN blog.

· View the CIM Explorer version history.

· Submit feedback and suggestions.

2.2 Real-life Example

Below is an example of how CIM Explorer can be used in a real-life scenario:

You work in IT Support, and you get a call about a failing battery in a user's computer. Instead of

trying to get information from the busy and inexperienced user, you decide to use Windows Power-

Shell.

You do not know which of the hundreds of CIM and WMI classes contain information about the bat-

tery. You can use Get-CimInstance -List, but it's quicker to launch CIM Explorer and search for battery

classes.

You start by connecting to the user's computer from CIM Explorer.

  On the Home tab > in the CIM section, click Connect and then connect to the user's computer.

5

https://docs.microsoft.com/en-us/powershell/module/CimCmdlets/Get-CimInstance?view=powershell-6
https://docs.microsoft.com/en-us/powershell/module/CimCmdlets/Get-CimInstance?view=powershell-6
https://www.sapien.com/blog/topics/cim-explorer/
https://www.sapien.com/software/version_history/CIM_Explorer_2024
https://www.sapien.com/requests/product_requests/4
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Next, you search for battery classes on the target computer. To make the search as efficient as pos-

sible, you uncheck all Search in options other than Class names.

  On the Home tab > in the Find section, click the Search icon.  

The search results appear in the Output panel.
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You are not familiar with these classes, so you use the Class and Property/Method displays to scan

the properties for the ones that would be useful. You settle on the Win32_PortableBattery class.

Then you run a basic query on the Win32_PortableBattery class on the user's computer. You find

two portable batteries, one in back and one in front.

  In the Class window > right-click Win32_PortableBattery, and then click Query this.

To drill down, you examine the property values for the suspect battery and find the information

needed.

  Click a battery class entry > in the Query section of the ribbon, click Property List.
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You export the information to a CSV file for your records.

  In the Export section of the ribbon > click CSV.

You would like to use this query in some scripts so you run it in the CIM Explorer PowerShell con-

sole. Then, you copy the PowerShell command into your script.

  In the Query section of the ribbon, click PowerShell > then right-click PowerShell and click

Copy PowerShell Code.
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2.3 How to Buy CIM Explorer

You can buy CIM Explorer online with all major credit cards. As soon as your transaction completes you

can download and install the program.

For answers to your pre-order questions, check out the SAPIEN Frequently Asked Questions or post in

the Trial Software / Pre-sales Technical Questions forum.

Order link and CIM Explorer product page

Online orders:

https://www.sapien.com/store/cim-explorer

Worldwide authorized resellers:

https://www.sapien.com/company/resellers

CIM Explorer product page:

https://www.sapien.com/software/cimexplorer

https://www.sapien.com/support/faqs
https://www.sapien.com/forums/viewforum.php?f=8
https://www.sapien.com/store/cim-explorer
https://www.sapien.com/company/resellers
https://www.sapien.com/software/cimexplorer
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3 Getting Started

This section provides information to help you install CIM Explorer and keep it up-to-date.

3.1 Installing CIM Explorer

To get started using CIM Explorer, follow the instructions below to download and install the program.

Downloading CIM Explorer

All SAPIEN Technologies software products are downloadable only. Download registered products

from your SAPIEN Account Registered Products page. 

Select the 64-bit version of CIM Explorer to download. The installer software will save to your default

download folder (e.g., CIM24Setup_2.4.111_010424_x64.exe).

  Starting with the CIM Explorer 2020 product release, 32-bit versions are no longer available. Cur-

rent owners of a license that includes a 32-bit product will have access to that from their SAPIEN Ac-

count Registered Products page. 

Want to try before you buy? You can download a trial version here.

Installing CIM Explorer

Follow these instructions to install CIM Explorer.

How to install CIM Explorer

1. In your default download folder, double-click on the downloaded program (e.g.,

CIM24Setup_2.4.111_010424_x64.exe). 

2. Reply Yes to the "Do you want to allow this app to make changes to your device?" prompt.

The installation wizard will first check several items, such as available disk space and the presence

of previous builds. If the environment is adequate, the installer will display the legal agreement

which you must accept to proceed:

a. Read the terms of the license agreement. 

b. Accept the terms of the license agreement. You should never accept license terms unless you

have read them, and you understand them.

c. Once you have accepted the terms, click Install. 

  The software will install in the default location as shown, unless you change the path.

https://www.sapien.com/account/products
https://www.sapien.com/account/products
https://www.sapien.com/account/products
https://www.sapien.com/software/cimexplorer


11

CIM Explorer - Help Manual 
 
                                                                                                                                                    © 2024 by SAPIEN Technologies Inc., all rights reserved

Getting Started

3. The installation may take several minutes. 

  The install time may take longer if the setup determines that some of the prerequisites

needed to run CIM Explorer are missing.
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4. CIM Explorer will build the WMI cache. 

5. When CIM Explorer successfully completes the installation, click Finish. 
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Troubleshooting Installation

If you encounter problems installing CIM Explorer, please report them in the Installation Issues sup-

port forum.

Activating and Deactivating CIM Explorer

Software activations are outlined in our End-User License Agreement. The number of activations al-

lowed will differ depending on your type of license. For Perpetual Licenses, each licensed user is al-

lowed to have a maximum of two devices activated and operating at any given time for personal

use. For Subscriptions*, each licensed user is allowed to have the software activated on a total of 20

devices with a maximum of two devices operating simultaneously at any given time for personal

use.

Product Activation

Registration is required to activate and operate the product, and also to obtain any customer service

https://www.sapien.com/forums/viewforum.php?f=29
https://www.sapien.com/forums/viewforum.php?f=29
https://www.sapien.com/company/eula
https://info.sapien.com/index.php/quickguides/sapien-software-subscriptions#UsingSubscription
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or technical support benefits. Registration only takes a few moments to complete and provides you

with access to special offers including preferred pricing on renewals. You will need an active internet

connection to complete product registration.

An active internet connection may not be required if you have a legitimate reason for needing offline

access. To request offline activation please fill out this request. All requests are considered on a case-

by-case basis. Please note: Activation keys belonging to Subscriptions* are not eligible for Offline

Activation.

* Information about software activations for Subscriptions only applies to SAPIEN Technologies

products with a Subscription purchase offer.

To activate CIM Explorer

The first time you launch a SAPIEN product, the Welcome screen is displayed.

The steps to activate the product vary depending on whether or not you already have a SAPIEN ac-

count. 

  Follow the steps in the Quick Guide to SAPIEN Software Activation to activate the software.

If you are unable to activate the product, contact sales@sapien.com.

Product Deactivation

Removing a software activation, also known as "deactivating", allows you to free up an activation for

use on another device.

https://info.sapien.com/index.php/quickguides/offline-license-file-replaces-offline-license-key
https://info.sapien.com/index.php/quickguides/offline-license-file-replaces-offline-license-key
https://www.sapien.com/account/requestkey
https://info.sapien.com/index.php/quickguides/sapien-software-subscriptions#UsingSubscription
https://info.sapien.com/index.php/quickguides/quick-guide-to-sapien-software-activation
mailto:sales@sapien.com?Subject=Activation%20Support
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You may deactivate your devices to free up your activations at your leisure, but there are certain cir-

cumstances where proper deactivation is crucial to prevent the loss of your allotted activations . 

  Uninstalling the software from your device does not deactivate the activation key. 

To deactivate your activation key

In the top-right of CIM Explorer above the ribbon, click the Activation Information button.

The Activation Information window will open.

  Follow the steps in the SAPIEN Software Activation / Deactivation FAQ to deactivate your activa-

tion key.

3.2 Staying Up-to-date

We are continually updating CIM Explorer, both to remove bugs and to add and improve product fea-

tures. We recommend always staying current with the most recent version to ensure that you are taking

advantage of the latest features, functionality, and product stability.

  The details for every CIM Explorer release are available in the version history.

Check for Updates

By default, CIM Explorer will automatically check for software updates. You can also manually check

for updates.

To check for updates

· On the Tools ribbon (Updates section) > click Check Now to open the SAPIEN Updates  tool

and see if there is a new CIM Explorer build available:

13

52

https://info.sapien.com/index.php/quickguides/sapien-software-activation-deactivation-faq
https://www.sapien.com/software/version_history/CIM_Explorer_2024
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3.3 Getting Help

This help manual has been designed to provide all the information you will need for using CIM Explorer.

In addition to the information in this guide, you can also ask questions in the online support forums .

  View CIM Explorer product feature demonstrations and release details on our blog.

Accessing the help manual 

To view the help manual online

· In CIM Explorer, select the Tools ribbon > then in the Help section, click View Manual. 

  The SAPIEN Information Center provides direct access to all of the SAPIEN product manuals.

User forums and support

Every registered CIM Explorer perpetual license with active maintenance includes basic support in our

CIM Explorer product support forum.

  If your CIM Explorer maintenance has expired, you must renew in order to obtain support.

Support Forums

Use the SAPIEN forums to get help with CIM Explorer, get answers to your scripting questions, sub-

mit feature requests, and more.

· CIM Explorer forum

· CIM Explorer feature requests

· Scripting support forums

· All SAPIEN support options

  To report a problem in the CIM Explorer forum, you will need to provide your SAPIEN product

and OS version information .

How to copy version information

To report a problem in the CIM Explorer forum, you will need to include the product version and

build, and also your OS version and build—and indicate 32 or 64-bit for each. 

To copy the required version information

1. Click the About button in the top-right of the CIM Explorer workspace. 

16

16

https://www.sapien.com/blog/topics/cim-explorer/
https://info.sapien.com/manuals/
https://www.sapien.com/forums/viewforum.php?f=24
https://www.sapien.com/store/renewals
https://www.sapien.com/forums/viewforum.php?f=24
https://www.sapien.com/requests/product_requests/4
https://www.sapien.com/forums/viewforum.php?f=6
https://www.sapien.com/support
https://www.sapien.com/forums/viewforum.php?f=24
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2. In the About CIM Explorer window, select Copy Version Info.

3. Paste the version information into your CIM Explorer forum post. 

https://www.sapien.com/forums/viewforum.php?f=24
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4 Basic Orientation

This section shows you how to easily customize your workspace, and explains the basic tasks you will

use when working with CIM Explorer. The topics are presented roughly in the order that you would per-

form the tasks.

4.1 Customizing Your Workspace

The CIM Explorer workspace can be easily customized to suit your personal preference.

Changing the color themed style

You can change the style (color theme) of the application to a predefined style. 

To change the style

· Click the Style menu on the top-right of the CIM Explorer window, then select a style:
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Manipulating workspace elements and the Ribbon

Output window

The Output window at the bottom of the CIM Explorer workspace can be resized, hidden, floated, or

docked: 

The Ribbon

The tabbed ribbon automatically resizes and compresses as you adjust the size of the CIM Explorer

application. 

You can also easily hide the ribbon.

To minimize the ribbon

· On the top-right above the ribbon, click the arrow to the left of the Send Feedback button

(Ctrl+F1):
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4.2 Find the Current Computer

This is the first in a series of brief topics to help you quickly get oriented to using CIM Explorer. 

By default, CIM Explorer displays and queries CIM/WMI on the local computer.

The name of the current computer is displayed in the title bar at the top of the screen and in the

status bar at the bottom of the screen.
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4.3 Search

Search is one of the most valuable features of CIM Explorer. You can search for a phrase in the name or

description of a CIM or WMI class, property, or method. You can also filter your search to make it more

efficient.

  Looking for the Win32_* classes? They're in the CIMV2 namespace. 

· In the namespace tree, click CIMV2.

· Then, in the Class window, click any entry, and then type W.

CIM Explorer has two related features, Search  and Find . 

  Start with Search, and then, if you need to filter further, use Find.

Search finds a text string in the name or description of a class, property, or method.

To start a search

1. To start a search, in the Find section of the menu, click Search. 

2. In Search for, type the search phrase. 

  Search is literal, so don't enter wildcard characters (*), quotation marks, or escape symbols. 

Set the Scope and Search in attributes.

3. You can also select a Filter (either before or after the search completes).

21 23
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4. View the results in the Search results pane. (It's one of the tabs in the Output window at the bot-

tom of the screen.)

5. To review the results, double-click each entry in Search results. Or, in the Find section of the

menu, click Previous Result and Next Result.

6. When you select an entry in Search results, the class and its members appear in the Class and

Property/Method panes.
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4.4 Find a String

The Find feature searches for a string in the results of a search or a query.

To find a string

1. In the Find section of the menu, type a string. 

  Find is literal, so don't enter wildcard characters (*), quotation marks, or escape symbols. 

2. To find more matches, in the Find section of the menu, click Find Previous and Find Next.
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4.5 Query

CIM and WMI objects represent the manageable aspects of a computer, including its hardware, soft-

ware, and environment. When you perform a successful query, the query returns a CIM/WMI object with

its properties and methods. You can use that information to manage the computer.

To query CIM/WMI, you can use WMI Query Language (WQL) or the Get-WMIObject or Get-CIMInstance

cmdlets. But, CIM Explorer does it for you!

To query all properties of a CIM or WMI class

1. Select a CIM or WMI class. 

  You can use the Namespace and Class windows to navigate to the class, or use the Search

and Find features to find the class. 

2. In the Query section of the ribbon, click Query (Ctrl+Q).

-OR-

Right-click the class name and select Query this.

https://technet.microsoft.com/en-us/library/jj679341.aspx
https://docs.microsoft.com/en-us/powershell/module/microsoft.powershell.management/get-wmiobject?view=powershell-5.1
https://docs.microsoft.com/en-us/powershell/module/CimCmdlets/Get-CimInstance?view=powershell-6
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To query selected properties of a CIM or WMI class

1. Select a CIM or WMI class. 

  You can use the Namespace and Class windows to navigate to the class, or use the Search

and Find features to find the class. 

2. In the Property/Method pane, select properties. 

  To select multiple properties, use Ctrl+Click and Shift+Click.

3. In the Query section of the ribbon, click Query (Ctrl+Q).
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-OR-

Right-click any highlighted item (a class name or a property name) and then click Query this. 
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  To get the query command that CIM Explorer ran, in the Query section of the menu, click the ar-

row key below the Query icon, and then click Custom Query:
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4.6 Query in PowerShell

You can also run CIM/WMI queries in a Windows PowerShell console. CIM Explorer runs a Get-CIMIn-

stance command in the Windows PowerShell console of the Output panel.

To create a PowerShell Query

1. In the Namespace and Class panes, select a class (or search for a class). 

  To query particular properties of the class, in the Property/Method pane, select the proper-

ties.

2. In the Query section on the ribbon, click PowerShell (Ctrl+P).

3. You can view and copy the output in the Windows PowerShell console and run follow-up com-
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mands. 

  To recall the command that CIM Explorer ran, click the arrow key beside the PowerShell icon

and then click Copy PowerShell Code:

4.7 Export Query Results

You can export the results of the most recent CIM/WMI query to a file and save it on any available file

system or cloud service.

To export the results of the most recent query 

· In the Export section of the menu, click an output format.

To export the results of the most recent query in PowerShell

· In the Windows PowerShell console in CIM Explorer, recall the command and pipe the result to

an Export cmdlet, such as Export-Csv or Export-Clixml. 

To export an HTML representation of the query results, use the ConvertTo-Html cmdlet and redir-

ect the output (>) or pipe it to the Out-File cmdlet.

http://go.microsoft.com/fwlink/?LinkID=113299
http://go.microsoft.com/fwlink/?LinkID=113297
http://go.microsoft.com/fwlink/?LinkID=113290
http://go.microsoft.com/fwlink/?LinkID=113254
http://go.microsoft.com/fwlink/?LinkID=113254
http://go.microsoft.com/fwlink/?LinkID=113363
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5 Remote Connections

You can use CIM Explorer to search and query CIM/WMI on a local or remote computer. This section

shows you how to work with remote connections.

5.1 Connect to a Remote Computer

To connect to a remote computer, either make a new connection or select from a list of connected com-

puters.

To connect to a remote computer

1. In the CIM group on the ribbon, click Connect. 

2. In the Connect box, type the computer name, an SSH root (if necessary), and the credentials of

a user with connection privileges:

To select from a list of connected computers

1. In the CIM group on the ribbon, click Connect. 

2. Click the ellipsis (...) in the Connect box, then select a remote computer and click OK:
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  When the command completes, the name of the remote computer appears in the title bar

and status bar:
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5.2 Disconnect and Reconnect

When you connect to a remote computer, CIM Explorer saves the connection settings for that computer,

including the user name and password:

To reconnect to the local computer

· Click the Connect arrow, and select the name of the local computer.
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To reconnect to a remote computer

· Click the Connect arrow, and select the name of the remote computer.

To connect to a new computer

· Click Connect.

5.3 Update Connection Data

When you connect to a remote computer, CIM Explorer saves your connection information, which

makes it quick and easy to reconnect.

To update changed credentials

· Click Connect and enter the same computer name with the new credentials. CIM Explorer will auto-

matically update the entry.

To manage stored connection information

· Click the File tab, and then click Servers... > then click a computer name and edit or delete the

stored information.

5.4 Update CIM/WMI Data

To improve CIM Explorer responsiveness, the CIM and WMI structures for the current computer are

cached during install. CIM and WMI structures do not change frequently, so the cache does not need to

be refreshed for each session. If necessary, you can update the CIM and WMI structures for the local or

remote computers as needed.  
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To update the CIM/WMI cache for a computer

· On the ribbon, click File > Clear Cache.

· CIM Explorer prompts you for confirmation, explaining that it updates the cache when it connects.

Click Yes to update the CIM/WMI cache on the local computer. 

  The cache update may take a few minutes to complete.

5.5 Troubleshooting Connections

Follow the instructions below if you are having issues establishing a connection to a Windows computer

from CIM Explorer. 

Requirements for enabling CIM Explorer to connect to a remote machine

· Allow Remote Administration through the Windows Firewall. 

· Allow remote access to COM security.

· Allow remote access to WMI root namespace and sub-namespaces.

To set these permissions you can run a script that we have provided that sets WMI access permis-

sions for Windows 8 and Windows 10. This script must be run elevated, that is, with the permissions

of a member of the Administrators group on the computer.

  You can open or copy the script from CIM Explorer, on the Tools tab > Permissions group:

Still need help?

If you have followed these instructions and you still cannot connect, create a post on the SAPIEN

CIM Explorer forum.

https://www.sapien.com/blog/2016/09/07/enable-wmi-explorer-remote-connection-permissions/
https://www.sapien.com/forums/viewforum.php?f=24
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6 Run in PowerShell

You can run the CIM Explorer search and query features in Windows PowerShell. This feature helps you

to automate your CIM/WMI queries and to learn the equivalent Windows PowerShell commands.

6.1 About Windows PowerShell Console

CIM Explorer includes a fully-featured Windows PowerShell console in the Windows PowerShell tab of

the Output panel. You can use the console to run any Windows PowerShell or PowerShell Core scripts

and commands, as well as import modules, and export objects.

The versions of PowerShell available in the Windows PowerShell panel are determined by the ver-

sions that you have installed. The console choices are determined dynamically on startup, so if you

install a new PowerShell Core version you simply need to restart CIM Explorer.

  The Windows PowerShell console is added, not hosted, so it uses the same Windows PowerShell

profile as the standard Windows PowerShell console, Microsoft.PowerShell_profile.ps1. 

To select a PowerShell version in the Windows PowerShell console 

· Click the drop-down arrow in the top-right of the console and select a PowerShell version: 

Switching between different instances enables you to verify that different CIM and WMI classes

can be used from PowerShell Core or from a different bit-level console.

To run a session without your profile

· In the Windows PowerShell panel of CIM Explorer (or any Windows PowerShell console), at the

prompt, type:

powershell.exe -noprofile
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To start a new session of Windows PowerShell console in CIM Explorer

· Right-click the console and then click Reset.

6.2 Run a CIM Query in PowerShell

You can run any CIM Explorer query in the PowerShell console in CIM Explorer.

To run a query

1. Create a query by selecting a class (with or without properties) or writing a custom query . 

2. In the Query group of the ribbon, click PowerShell (Ctrl+P).

CIM Explorer runs the query in the Windows PowerShell console.

· To run a default query, CIM Explorer uses the Get-CIMInstance cmdlet with the ClassName and

Runspace parameters.

· If the query includes properties, CIM Explorer pipes the output of the Get-CIMInstance command

to the Format-Table cmdlet. It uses the Property parameter with the specified properties as values,

and the AutoSize parameter which formats the output without extraneous spaces.

45

https://docs.microsoft.com/en-us/powershell/module/CimCmdlets/Get-CimInstance?view=powershell-6
http://go.microsoft.com/fwlink/?LinkID=113303
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To save the output of the command (or any part of the command in a variable)

· In the console, use the up-arrow to recall the last command and then edit the command line.

  To run a Get-CimInstance command for the Win32_Computer class on the local computer, do

not use the ComputerName parameter.

6.3 Get the PowerShell Command for a Query

After testing a query in CIM Explorer you might want to add it to a script that you are writing in a Win-

dows PowerShell editor, such as PowerShell Studio, PrimalScript, or PrimalPad. 

To get the equivalent Windows PowerShell command for a query

1. Create a query by selecting a class (with or without properties) or writing a custom query. 

2. In the Query group of the ribbon, click the arrow beside PowerShell (Ctrl+P), and then click Copy

PowerShell Code.

Copy PowerShell Code copies the Windows PowerShell command to your Windows clipboard. 

https://docs.microsoft.com/en-us/powershell/module/CimCmdlets/Get-CimInstance?view=powershell-6
https://www.sapien.com/software/powershell_studio
https://www.sapien.com/software/primalscript
https://www.sapien.com/software/sapien_free_tools
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To paste the command in a standard Windows PowerShell console

· Simply right-click.

To paste the command in most other documents and editors, including the PowerShell console

in CIM Explorer

· Right-click and select Paste (Ctrl+V).

To edit the command after pasting the command in the CIM Explorer PowerShell console

· You can use the Select-Object cmdlet to specify property names instead of using the Format-Table

cmdlet. The result is a custom object (PSCustomObject) that you can pipe to other cmdlets.

Get-CimInstance -ComputerName SAPIEN01 -ClassName Win32_LogicalDisk |
Select-Object -Property DeviceID, Caption

6.4 Show and Hide the Console

The PowerShell console in CIM Explorer appears in the Windows PowerShell tab in the Output panel. By

default, the Output panel and its tabs appear at the bottom of the CIM Explorer window.

To display the PowerShell console

· In the Output panel at the bottom of the screen, click the Windows PowerShell tab.

-OR-

· If the Output panel or the tab are hidden, in the View group on the ribbon, click PowerShell.

https://docs.microsoft.com/en-us/powershell/module/microsoft.powershell.utility/select-object?view=powershell-6
https://docs.microsoft.com/en-us/powershell/module/microsoft.powershell.utility/format-table?view=powershell-6
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To hide the PowerShell console

· In the View group on the ribbon, uncheck PowerShell.

To hide the Output panel (and all of its tabs)

· Right-click the title bar of the Output panel, and then click Hide.
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7 Create and Run Queries

You can use CIM Explorer to create and run queries on local and remote computers. This section shows

you how to run queries and examine query results.

7.1 Ways to Query Data

The simplest way to create and run a query for any CIM or WMI class on the currently connected com-

puter is to select a class and click the Query button, or right-click and select Query this.

To query all properties of a CIM or WMI class

1. Select a CIM or WMI class. 

  You can use the Namespace and Class windows to navigate to the class, or use the Search

and Find features to find the class. 

2. In the Query section of the ribbon, click Query (Ctrl+Q).

-OR-

Right-click the class name and select Query this.
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To query selected properties of a CIM or WMI class

1. Select a CIM or WMI class. 

  You can use the Namespace and Class windows to navigate to the class, or use the Search

and Find features to find the class. 

2. In the Property/Method pane, select properties. 

  To select multiple properties, use Ctrl+Click and Shift+Click.

3. In the Query section of the ribbon, click Query (Ctrl+Q).

-OR-

Right-click any highlighted item (a class name or a property name) and then click Query this. 
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7.2 Run a PowerShell Query

You can run queries in the Windows PowerShell console in CIM Explorer. 

  For more details, see Run in PowerShell .

When you run a query in the PowerShell console, you can view and edit the PowerShell command

that CIM Explorer generates, and pipe the command to other cmdlets.

To create a PowerShell Query

1. In the Namespace and Class panes, select a class (or search for a class). 

  To query particular properties of the class, in the Property/Method pane, select the proper-

36
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ties.

2. In the Query section on the ribbon, click PowerShell (Ctrl+P).

3. You can view and copy the output in the Windows PowerShell console and run follow-up com-

mands. 

  To recall the command that CIM Explorer ran, click the arrow key beside the PowerShell icon

and then click Copy PowerShell Code:
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7.3 Run a Custom Query

Most CIM/WMI queries are relatively simple, but occasionally you may want to create a more complex

query. 

To create a custom query

Start with a basic query:

1. Select a CIM or WMI class. 

  You can use the Namespace and Class windows to navigate to the class, or use the Search

and Find  features to find the class.

2. [Optional] In the Property/Method pane, select properties. 

  To select multiple properties, use Ctrl+Click and Shift+Click.

3. On the ribbon, in the Query group, click the arrow under the Query button, and then select Cus-

tom Query.

  CIM Explorer displays the current query in WMI Query Language (WQL). 

4. In the Custom Query window, edit the original WQL query to include the custom options, then

click OK.

21

23

https://technet.microsoft.com/en-us/library/jj679341.aspx
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7.4 Examine Query Results

When you run a query, CIM Explorer automatically displays the results in table format in the Query Res-

ults tab of the Output pane:

  By default, query results are displayed in a table with one row for each result.
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  To get the query command that CIM Explorer ran, in the Query section of the menu, click the arrow

key below the Query icon, and then click Custom Query.

To view the same query results in list format

· On the ribbon, in the Query group, click Property List:

To see the property values of a selected object in the results

· In the Query results pane, click to select an object. Then, in the Query section of the menu, click

Property List.

If you need help understanding the classes or the property values, use the Description field of the

Class and Property/Method displays.
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To examine the results in Windows PowerShell

· On the ribbon, in the Query group, click PowerShell:
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8 Advanced Features

In addition to the features covered in Basic Orientation , CIM Explorer has advanced features to make

it easier to search CIM/WMI and refine your queries.

8.1 Find a Class, Property or Method

The Find feature finds strings in the names of classes, properties, and methods that CIM Explorer dis-

plays. If you click a namespace and use Find, Find locates classes in the namespace. If you click a class, it

finds properties and methods in the class.

To find a string in a class name

1. In the Namespace pane, select a namespace. 

2. On the ribbon, in the Find group, enter the word you want to find.

3. Press Enter, or click Find Next or Find Previous.

To find a string in a property or method name

1. In the Namespace pane, select a namespace. 

2. In the Class pane, select a class.

3. On the ribbon, in the Find group, enter the word you want to find.

4. Press Enter, or click Find Next or Find Previous.

8.2 Filter Results

You can filter the results of the Search, Find, and Query features in CIM Explorer. When set, the Filter fea-

ture includes strings and excludes categories of classes from the results.

18
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To exclude categories of classes from CIM Explorer results

· Click the buttons to select from the options. 

From left to right:

o Exclude CIM classes (class names that begin with 'CIM_')

o Exclude Win32 classes (class names that begin with 'Win32_')

o Exclude system classes (class names that begin with '__System')

o Exclude performance classes (class names that include 'Perf')

o Exclude MSFT classes (class names that begin with 'MSFT_')

To include only classes with a specified word in the class name

· In the Filter box, type the word.

For example, if you type Alarm, CIM Explorer displays only classes with 'Alarm' in the class name.

8.3 Export Results

You can export query results in HTML, Text, XML, or CSV format.

To export results

1. Run a query. For help, see Create and Run Queries . 

2. On the ribbon, in the Export group, select an output format:

3. Navigate to the path and assign a file name for the exported file.

To export results from a Windows PowerShell query, use the cmdlets

· HTML

41
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ConvertTo-HTML | Out-File

· Text

Out-File or Set-Content

· XML

Export-Clixml

· CSV

Export-CSV

8.4 Display WMI Help and Examples

CIM Explorer includes help for all classes, properties, methods, and dynamically generated examples that

you can run to query WMI on your local computer.

To display help for a class, property, or method

· Select the element > in the Output panel, click the Help tab.

To run an example

· Click the Run link.
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9 Reference

This section provides an overview of the SAPIEN Updates tool, and lists the keyboard shortcuts available

in CIM Explorer.

9.1 SAPIEN Updates

We are continually updating our software, both to remove bugs and to add and improve product fea-

tures. We recommend always staying current with the most recent versions to ensure that you are taking

advantage of the latest features, functionality, and product stability. 

Every SAPIEN product has a built-in update tool—SAPIEN Updates—which will check for updates on all

current activations and unexpired trial versions of our products. Available product updates are indicated

in the SAPIEN Updates tool and also in the Notifications dialog  (see below).

SAPIEN Notifications

SAPIEN products provide automatic notifications when there is a software update available, or when

your maintenance is about to expire. Notifications are indicated by a 'flag' icon in the top-right of

the program window:

How to view SAPIEN notifications

· Click the notification flag icon above the ribbon to open the Notifications dialog:

· If a product update is available, click the update notification to open the SAPIEN Updates tool.

  Click the X button to dismiss individual notifications or select Dismiss All. Dismissed notifica-

tions will not be shown again.

SAPIEN Updates - Tool Overview

The SAPIEN Updates tool indicates when an update is available for any SAPIEN program installed on

your computer. 

52
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  To minimize the impact on your system, the tool does not run during Windows startup or con-

tinuously in the system tray.

How to access the SAPIEN Updates tool

· On the Help or Tools ribbon > click Check Now or Check For Updates (Updates section).

-OR-

· Click the notification icon  above the ribbon > then in the Notifications dialog, click the up-

date notification.

SAPIEN Updates Tool

SAPIEN Updates Tool

52
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SAPIEN Updates - Options

Check for updates now Immediately checks to see if additional product

updates are available.

View Downloads folder Displays the Downloads folder in File Explorer.

View update history Displays the history of all downloaded and in-

stalled product updates.

Available Displays a selectable list of available product

updates.

  Select one or more products to Download

or Download and Install.

Download and Install Downloads and installs the updates for the

product(s) selected in the Available updates list.

Download only Downloads the updates for the product(s) selec-

ted in the Available updates list.

Close Closes the SAPIEN Updates tool.

Notes Displays a brief synopsis of what was changed,

added, or fixed for the products selected in the

Available window.

  The build history for all SAPIEN products is

available here.

Update On-Demand

You don't need to wait to be notified when an update is available; you can check for updates at any

time. This is particularly useful if you've heard about a new update and want to install it immediately,

or if you are ready to start a new project and want to complete all updates before you begin. 

How to check for updates on-demand

· On the Help or Tools ribbon > select Check Now or Check For Updates to open the SAPIEN

Updates tool.

  These instructions may vary between SAPIEN products.

https://www.sapien.com/software/version_history
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· In the SAPIEN Updates tool, select Check for updates now:

The latest product updates are displayed in the SAPIEN Updates Available window.

Security and Permissions

Installing updates to programs in a Program Files directory requires the permissions of a member of

the Administrators group on the computer. When you click Download and Install in the SAPIEN Up-

dates tool, or if you install after downloading, you will be prompted for administrator credentials.

The update tool requires a functioning internet connection and unimpeded access through your in-

ternet firewall. For some installations, you might need to create a firewall rule to allow access or

make some accommodations. 

9.2 Keyboard Shortcuts

This section covers the keyboard shortcuts available in CIM Explorer.

General Commands

Copy Ctrl + Shift + C

Connect to another computer Ctrl + N

Minimize the Ribbon Ctrl + F1

Search Commands 

Search Microsoft Learn Ctrl + M

Search Google Ctrl + G
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Find Commands

Search classes, properties, or methods Ctrl + S

Previous Result Shift + 4

Next Result F4

Find Previous Shift + F3

Find Next F3

Query Commands

Query Ctrl + Q

Query - select multiple properties Ctrl + Click or Shift + Click

Query Property List Ctrl + L

Query with PowerShell Ctrl + P

9.3 Appendices

Appendices for CIM Explorer Help Manual

Appendix A: Manual and Product Version

Appendix B: Icon License Attribution

9.3.1 Appendix A: Manual Version

Appendix A

Manual Version
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This help manual is in the process of being updated. Some features and images in this manual version

may not reflect the current product functionality. 

Blog articles

For the latest product tips and feature demonstrations, check out the CIM Explorer articles on the

SAPIEN blog.

Release details

To view a brief description of what was changed, added, or fixed in the most recent CIM Explorer builds,

view the product version history.

Need more help?

Please direct your product related questions to the CIM Explorer support forum, and your scripting

questions to the appropriate Scripting Answers forum.

9.3.2 Appendix B: Icon License Attribution

Appendix B

Icon License Attribution

Some of the icons used in this manual were made by Freepik at www.flaticon.com and are licensed un-

der CC BY 3.0:        

https://www.sapien.com/blog/topics/cim-explorer/
https://www.sapien.com/software/version_history/CIM_Explorer_2024
https://www.sapien.com/forums/viewforum.php?f=24
https://www.sapien.com/forums/viewforum.php?f=6
https://www.flaticon.com/authors/freepik
http://www.flaticon.com
http://creativecommons.org/licenses/by/3.0/
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